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Your Best STL Learning Tools

Welcome to your Best STL training course.

As part of your training, we provide you with the following tools and resources to support and enhance your learning experience.

Thank you for choosing Best STL.
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Quick reference: Word shortcut keys
	Command
	Keystroke

	Bold
	Ctrl+B

	Close
	Ctrl+F4

	Copy
	Ctrl+C

	Cut
	Ctrl+X

	Exit Word
	Alt+F4

	Font
	Ctrl+D

	Font grow/shrink 1 pt.
	Ctrl+ ] or [

	Help
	F1

	Help—What’s This?
	Shift+F1

	Hyperlink
	Ctrl+K

	Italics
	Ctrl+I

	Justify—Center
	Ctrl+E

	Justify—Full
	Ctrl+J

	Justify—Left
	Ctrl+L

	Justify—Right
	Ctrl+R

	Line-spacing 1
	Ctrl+1

	Line-spacing 1.5
	Ctrl+5

	Line-spacing 2
	Ctrl+2

	List Bullet
	Ctrl+Shift+L

	New document
	Ctrl+N

	Open a document
	Ctrl+O

	Paste
	Ctrl+V

	Print
	Ctrl+P

	Print Preview
	Ctrl+Alt+I

	Repeat/Redo
	Ctrl+Y

	Underline
	Ctrl+U

	Underline—double
	Ctrl+Shift+D

	Save
	Ctrl+S

	Select All
	Ctrl+A

	Spelling and Grammar check
	F7

	Table—to column bottom
	Alt+PgDn

	Table—to column top
	Alt+PgUp

	Table—to row beginning
	Alt+Home

	Table—to row end
	Alt+End

	Undo
	Ctrl+Z


Unit 1 : Getting Started

Objectives
· Explain the elements of the Word window 
· Create and save documents 
· Access and use Help 
Elements of the Word window

	1. 
	File Tab (Backstage)
	7.
	Group of buttons

	2. 
	Quick Access Toolbar
	8.
	Ruler

	3. 
	Title bar
	9.
	New document

	4. 
	Minimise Window
	10.
	Vertical scroll bar

	5. 
	Tabs
	11.
	Status bar

	6. 
	Ribbon
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	Create a new document
	
	

	
	[image: image3.png]



	
	1. File Tab ( New, or Ctrl + N
2. Blank document

3. Create

	Saving a document
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	1. File Tab( Save, or Ctrl+S
2. Select Location to save to 

3. Enter filename

4. Save

Use Ctrl+S to save additional changes made to your document

	Using Help
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	Click 
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 or press F1 to launch Help


	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Practice Activity – Introduction to MS Word

1. Create a new document.

2. Type “I have learned the basics of using Word to create, save, and print a document.  I also know how to use Help.”

3. Save the document as My achievements.

4. Find the Help topic on Opening a file.
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	Online advice and support forum

www.microsofttraining.net/forum

Visit our forum to have your questions answered by our Microsoft qualified trainers.


Unit 2 : Editing Documents

Objectives
· Open and move around a document 
· Use Word’s AutoCorrect feature 
· Edit text in a document 
· Use the Undo and Redo commands 
· Search for and replace text
	Open a document
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	1. File Tab ( Open, or Ctrl+O
2. Select the Location the file is saved in

3. Click on the file once

4. Open

	Open a recently used document
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	File Tac (Recent

Select document from Recent Documents list

	Navigating a document using the scroll bar
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	On the vertical scroll bar, click up or down arrows, or click on and drag place marker
	
	


	Navigating a document using the keyboard
	
	

	Page Up
	Move up the document
(toward first page)
	
	

	Page Down
	Move down the document
(toward last page)
	
	

	Home
	Move to start of a line
	
	

	End 
	Move to the end of a line
	
	

	Ctrl+Home
	Move to the start of the document
	
	

	Ctrl+End
	Move to the end of the document
	
	

	Using Go To
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	1. Home tab( Find(Go to
or Ctrl+G
2. Select Page on left

3. Enter page number

4. Go To

	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Edit text in a document
	
	

	Backspace
	Remove the character to the left of the cursor
	
	

	Delete
	Remove the character to the right of the cursor
	
	

	Overtype
	Replaces text as you type

Turn off or on by pressing Insert key or double-click on the letters OVR in the status bar at the bottom of the screen
	
	

	Undo and Redo
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	Both buttons are located on the Quick Access toolbar.
	
	

	Undo
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	Redo
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	Undo reverses the previous action taken, shortcut is Ctrl+Z
	

	
	
	
	
	Redo repeats actions that have been undone, shortcut is Ctrl+Y
	

	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Autocorrect feature
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	To view existing AutoCorrect entries:

1. Go to Insert tab(Symbols group

2. Click Symbol and select More Symbols

3. Click AutoCorrect

To create an entry:

1. Type mis-spelt entry into Replace box, and correctly spelt entry into With box

2. Click OK.
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	Find and Replace
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	1. Home tab(Editing group

2. Use Find to search for a word; or Replace to replace one word with another
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	Use shortcut keys Ctrl+F for Find
Ctrl+H for Replace

	
	
	

	
	
	

	Practice Activity – Editing Documents

1. Open the file Celebrate.
2. Add an Autocorrect entry for the word Outlander; to change Otulander to Outlander.

3. Move to the heading The Project team on page 2.

4. Move the insertion point to the left of the P in “Project”. Type Otulander and press the spacebar.

5. Go to the top of page 3.

6. Overwrite the word Closing with Summary.

7. Use Undo to reverse your typing.

8. Save the document as My Celebrate and close it.
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	Online advice and support forum

www.microsofttraining.net/forum

Visit our forum to have your questions answered by our Microsoft qualified trainers.


Unit 3 : Moving and Copying Text

Objectives
· Select text by using the mouse and keyboard
· Copy and move text 
	Selecting text using the mouse
	
	

	Select a word
	Double-click on the word
	
	

	Select a paragraph
	Triple-click within the paragraph
	
	

	Select several paragraphs
	From left margin using
	
	

	Selecting text using the keyboard
	
	

	Select a line
	Ctrl+End (cursor positioned at start of line), or
	

	
	Ctrl+Home (cursor positioned at end of line)
	

	Select a paragraph
	Ctrl+Shift+Down Arrow (cursor positioned at start of paragraph),
or

	
	Ctrl+Shift+Up Arrow (cursor positioned at end of paragraph)

	Select whole document
	Ctrl+A
	
	

	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Move or copy text using the mouse
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	To move select text, then click on the text and drag to the new location.

To copy select text, then hold down the Ctrl key.
Click on the text and drag to the new location.

	Move or copy text using Cut, Copy and Paste
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	Cut
	
	1. Select text

2. Home tab(Clipboard group

3. To move, select Cut or Ctrl+X

To copy, select Copy or
Ctrl+C
4. Position cursor where the text is to go

5. Select Paste or
Ctrl+V
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	Paste
	
	6. 

	
	
	
	
	7. 

	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Practice Activity – Moving and Copying Text

1. Open Info.
2. Select the heading The Project Team and related text up to the heading To-do list.

3. Move the selected text to the end of the document.

4. Search for the word ‘find’ and replace it with ‘identify’.

5. Save the document as My info.

6. Close the document.
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	Online advice and support forum

www.microsofttraining.net/forum

Visit our forum to have your questions answered by our Microsoft qualified trainers.


Unit 4 : Formatting Characters and Paragraphs

Objectives
· Use character formatting to enhance text 
· Use basic paragraph formatting to enhance a document’s appearance
· Use tabs in a document 
	Applying character formatting – font and font size
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	1. Select the text to be formatted

2. Home tab(Font group(select font or font size



	
	
	
	
	Shortcut keys
Select text and use

· Ctrl+]
to increase font size by 1pt

· Ctrl+[
to decrease font size by 1pt

	Other character formats
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	1. Select the text to be formatted

2. Home tab(Font group(click 
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 in bottom right of Font group
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	From the Font dialogue box effects such as:

· Strikethrough

· Superscript

· Subscript

· Shadow

can be applied.

	
	
	
	


	Using paragraph formats
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	Paragraph formatting commands can be found on the
Home tab(Paragraph group.

	View paragraphs
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	Click the Show/Hide button in the Paragraph group to reveal paragraphs and other non-printing characters in a document.

	Paragraph alignment
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	Left alignment
Ctrl+L
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	Right alignment
Ctrl+R
	
	To change alignment:

1. Select the paragraph(s) to be aligned.

2. Click an alignment button in the Paragraph group.
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	Centre alignment
Ctrl+E
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	Justify alignment
Ctrl+J
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	Indentation
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	To change indentation:

1. Select the paragraph(s) to be indented.

2. Click an indentation button (Decrease Indent or Increase Indent) in the Paragraph group.

	Line spacing
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	To change line spacing:

1. Select the paragraph(s) to apply line spacing to.

2. Select line spacing using the dropdown arrow next to Line Spacing button.

	Bullet and numbering
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	To apply bullets or numbering:

1. Select the paragraphs to be bulleted or numbered.

2. Click the Bullets button or Numbering button to apply.

	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Tabs – viewing the ruler
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	Ensure the ruler is visible near the top of the screen:

View tab( tick Ruler checkbox in Show/Hide group.

	Selecting a tab type
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	To select a tab type, click on the tab button to the left of the ruler to cycle through different tab types.

	
	
	

	Types of tabs
	
	

	Left tab
	Text starts at the tab position and flows to the right as you type.
	
	To set a tab:

1. Select the tab type at the left of the ruler.

2. Click on the ruler at the point where the tab is to be positioned.

3. Press the Tab key to shift the cursor to the tab position; and begin typing.

	
	
	

	Right tab
	Text starts at the tab position and flows to the left as you type.
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	Centre tab
	Centre of the text is at the tab position.
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	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Viewing tabs
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	To view tabs on the screen:

1. Go to the Home tab(Paragraph group.

2. Click the Show/Hide button.

Tabs will show as small arrows.

	Working the tabs dialogue box
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	To change current tab settings, or remove tabs:

1. Double-click on a tab marker on the ruler.

2. Select the tab stop to be altered or removed from the list of tab stops on the left.

Now the alignment for the selected tab can be changed; or the tab can be cleared.

	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Practice activity – Formatting Characters and Paragraphs

1. Open Status report.

2. Select Status Report at the top of the page and apply the following character formats:  Arial, 14pt, Bold.

3. In the first paragraph under the memo heading, apply an italic format.

4. Set a left aligned tab stop at 5cm for the lines TO: FROM: and RE:

5. Justify the first paragraph under the double line and set the line spacing to 1.5 lines.

6. Bold the heading The consultant team.

7. Repeat the formatting for the headings What’s done and Still left to do.

8. Apply bullets to the items under the headings What’s done and Still left to do.

9. Set a left indent at 1.5cm and a right indent at 11cm for the paragraph under Kathy Sinclair.

10. Repeat the indents for the paragraphs under Thomas Boorman, Solena Hernandez, and Susan Gianni.

11. Centre the heading Status Report at the top of the page.

12. Save the document as My Status Report and close it.
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	Online advice and support forum

www.microsofttraining.net/forum

Visit our forum to have your questions answered by our Microsoft qualified trainers.


Unit 5 : Creating and Managing Tables

Objectives
· Create tables in a Word document 
· Edit the structure of tables
· Enhance the appearance of tables  
	Insert a table
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	To create a table:

1. Go to the
Insert tab(Table button.

2. Select the number of cells to be included by dragging the mouse over the grid;

or

Select Insert Table.

	
	
	To add text:

1.  Click in a cell and type.

2. Press Tab to move to the next cell.

	Inserting rows or columns
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	To insert additional rows or columns into a table:

1. Click in a cell next to where the row or columns is to be added.

2. Go to the Table Tools Layout tab(Rows & Columns group.

3. Click the appropriate Insert button.
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	Deleting rows or columns
	
	

	[image: image58.png]city

Max Temperature (°CJ[






	
	To delete rows or columns from a table:

1. Click in a cell within the row or column is to be deleted.

2. Go to the Table Tools Layout tab(Rows & Columns group.

3. Click the appropriate Delete option from the dropdown arrow next to Delete.
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	Using AutoFit options
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	AutoFit options are used to adjust the size of the table columns automatically.

1. Click in a cell within the table.

2. Go to Table Tools Layout tab(
Cell Size group.

3. Click the dropdown arrow next to the AutoFit button to select an AutoFit option.
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	Changing cell text alignment
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	To align text within a cell:

1. Click in the cell containing the text, or select the column or row.

2. Go to Table Tools Layout tab(
Alignment group.

3. Select the alignment option to be used.
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	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Practice Activity - Tables

	1. Create a new blank document.

2. Insert a table with 4 columns and 5 rows.

3. Add the text for the first 5 rows as shown in the sample table below.

Tea

Vendor

Order Status

Comments

Oolong

East Seas

In Route

2 Weeks late

Darjeeling

China Clipper

In Warehouse

Excellent quality

Earl Grey

House of Lords

In Warehouse

Not fresh – consider other options

House Blend

China Clipper

Shipping next Week

New product for this vendor

4. Add a sixth row at the bottom of the table.

5. Add the following text:

Tea:  House Blend

Vendor:  China Clipper

Order Status:  Shipping next week

Comments:  New product for this vendor


6. Select the first row.

7. Format the font as Arial, Bold, 14pt.

8. Centre the text in the first row.

9. Change the width of the last column to accommodate all the text on one line (use Autofit).

10. Save the document as Tea.

11. Close the document.
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	Online advice and support forum

www.microsofttraining.net/forum

Visit our forum to have your questions answered by our Microsoft qualified trainers.


Unit 6 : Controlling Page Layout

Objectives
· Add headers and footers to a document 
· Set and change the margins for a document 
· Add and delete manual page breaks 
	Accessing the header or footer
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	To access the header or footer:

1. Go to Insert tab(click Header button or Footer button.

2. Select a built-in option

or

Select Edit Header or Edit Footer.

	Editing the header or footer
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	Type into the header or footer, then use the Tab key to move across to the next tab stop position.

	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Navigating and inserting page numbering
	
	

	[image: image68.png]Header & Footer Tools.

Design




	
	
	On the Header & Footer Tools/Design tab:

· Use the Go to Footer or Go to Header button to navigate between the two areas

· Use the Page Number button to insert page numbering

· Click Close Header and Footer to exit.

· 
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	Changing document margins
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	To change a document’s margins:

1. Go to Page Layout tab(Page Setup group.

2. Click the Margins button.

3. Select from preset margin options; or use Custom Margins to enter margin sizes.
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	Inserting a page break
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	To insert a page break:

1. Click the cursor where the page break is to be positioned.

2. Go to the Insert tab(Page Break button.


Shortcut keys:
Ctrl+Enter to insert a page break.

	Delete a page break
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	1. Turn on the Show/Hide button (Home tab(
Paragraph group).

2. Click the cursor to the left of the page break.

3. Press the Delete button on the keyboard.


	Practice activity – Controlling page layout

	1. Open James.
2. Add the date to the centre of the header.

3. Add Outlander Spices to the footer.

4. Set all margins to 3cm.

5. Insert a page break above the heading “Progress to date”

6. Save the document as My James and close the file.
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	Online advice and support forum
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Unit 7 : Using Proofing Tools

Objectives
· Use Word’s Spelling and Grammar feature to proof a document 
· Use Word’s Thesaurus to find alternative words 
	Using the spelling and grammar checker
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	To launch the Spelling and Grammar checker, go to Review tab(Spelling & Grammar button
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	To ignore the suggestion, click Ignore Once or Ignore All.

Use Add to Dictionary to add a correctly spelt word to Word’s dictionary (so the word won’t come up as an error in future).

To correct an error to a suggested option, click Change or Change All.

	Spelling and grammar checking options
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	To change spelling and grammar options, go to Office button(Proofing category.

	
	
	

	Using the thesaurus
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	To look up/use an alternative word:

1. Right-click on the word.

2. Go to Synonyms and select another word to replace the one currently used.

	Practice activity - Using proofing tools

	1. Open Finalreport.
2. Correct the spelling and grammar in the document.

3. Select the word “initial” in the 4th bullet.

4. Use Thesaurus to replace the word “initial” with a word of your choice.

5. Save the document as My Finalreport and close the document.
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Unit 8 : Web Features

Objectives
· Saving documents as web pages
· Working with hyperlinks
· Emailing documents 
	Creating a hyperlink
	
	

	[image: image83.png]See ourwebsite




	[image: image84.png]B, Hyperiink
4 Bookmark

1) Cross-reference
Links




	
	To create a hyperlink:

1. Select the text that is to become a hyperlink.

2. Go to the
Insert tab(Links group.

3. Click the Hyperlink button.

4. Create hyperlink settings using the Insert Hyperlink dialogue box.

5. Click OK.

6. Use Ctrl+Click to test the hyperlink.


Shortcut keys:
Ctrl+K to access Insert Hyperlink dialogue box.
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	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Emailing a document from Word (using Outlook)
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	To email an open document from Word using Outlook:

1. Go to File Tab(Send and save(
Email.

2. A new Outlook email message opens, with the open Word file attached.

3. Enter recipients’ email addresses and send.

	
	
	


	Save a document as a web page
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	1. Go to the File Tab(Save As(
Save As Type

2. Select Web Page as the file type under Save as type.

3. Save.
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	Notes
	
	

	
	
	

	
	
	

	
	
	

	
	
	


	Practice Activity – Web Features

1. Open Team.

2. Save the file as a web page called My Team.

3. Open My Team in Internet Explorer.

4. At the bottom of the page, make the text Back to previous page a hyperlink to the file My about us.htm
5. Click the hyperlink to display the HTML file.

6. Close Internet Explorer.

7. Update and close the document.

8. Close Word.
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